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1 Program Summary 
 
“TRWinProg” is a Windows PC program for the programming of TR devices. This 
means that all TR product areas such as rotary encoders, linear encoders, laser 
distance measuring devices, transformation measuring systems, displays, etc., can be 
programmed via a software. 
 
Each device is defined by a so-called “Device file” (*.tr). All device-specific parameters 
are included in this device file and preset to a default value. When TRWinProg 
recognizes a device connected to the PC, the device file suitable for device is loaded 
into the PC program and the user interface is adjusted according to the device 
parameters required. In other words, only so many menus are displayed as tabs as is 
necessary for programming the connected device. A parameter list can additionally be 
used to specify which parameters to show or hide in each menu. 
The user can therefore customize the user interface according to the requirements of 
his application. These settings can be saved to a so-called “parameter file” (*.prm) and 
restored by simply loading the file. Moving to a new application is therefore quick and 
easy. 
 
PC and TR device communicate via an RS-232 or USB port on the PC. A PC adapter 
is required for converting the device, RS-422 or RS-485 signals to the RS-232 or USB 
signals. This ensures a potential separation between the PC and the connected 
device and longer ranges can be achieved. 
TRWinProg also supports the connection of an infrared COM interface adapter 
according to the IrDA 1.0 standard. An external power supply for the adapter is not 
required as the power is supplied by the COM port of the PC. The communication 
distance between the IR adapter and the device is between 0 and about max. 200 cm 
and thus allows easy and wireless programming. 
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2 Safety instructions 
 

2.1 Definition of symbols 
 

 

indicates important information or features and application 
tips for the software used. 

 
 
 
 

2.2 Organizational measures 
 
Personnel working with the measuring system must have read and understood the 
applicable installation instructions, particularly the chapter “Basic safety instructions”, 
prior to commencing work. 
 
Internet download 

• Installation instructions 
 
  

http://www.tr-electronic.com/service/downloads/operating-manuals/encoder-and-linear-transducer.html#c17358


System requirements 

 

 TR-Electronic GmbH 2001, All Rights Reserved Printed in the Federal Republic of Germany 

Page 8 of 33 TR - E - BA - GB - 0023 - 05 07/14/2017 

3 System requirements 
 

3.1 Software 490-00416 
 

• PC (Windows® compatible) 

Minimum requirements: 
- From computer version 80-486 
- 40 MB of free disk space 
- 32 MB RAM 
- CD-ROM drive 
- a free USB 2.0 port or 
- an additional COM port 
 

• Operating system: 

Windows® - 95 / -98 / -Me / -NT 4 / -2000 / -XP 
 

• Interface adapter: 

USB, RS232 <--> RS485, RS422, IrDA 
 
 
 
 

3.2 Software 490-00416_WIN7 
 

• PC (Windows® compatible) 

Minimum requirements: 
- From computer version 80-486 
- 40 MB of free disk space 
- 32 MB RAM 
- CD-ROM drive 
- a free USB 2.0 port or 
- an additional COM port 
 

• Operating system (32-Bit / 64-Bit): 

Windows® - Vista / -7 / -8 / -8.1 and higher 
 

• Interface adapter: 

USB, RS232 <--> RS485, RS422, IrDA 
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4 Program installation 
 
The PC program “TRWinProg” is usually delivered on a CD-ROM or can be 
downloaded from TR-Electronic at the following link: 
 
http://www.tr-electronic.com/service/downloads/software.html 
 
 You can use Windows Explorer to find the file “Setup.exe” in the root directory of the 
CD-ROM if the default settings of your Windows system do not automatically start the 
setup program when you insert the TRWinProg CD into your CD-ROM drive. 
 
The installation begins when you double click the “setup.exe” file with the left mouse 
button. Then follow the instructions of TRWinProg Setup Program. 
 
 

 
 
 
  

http://www.tr-electronic.com/service/downloads/software.html
http://www.tr-electronic.com/service/downloads/software.html
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5 Connecting devices to the PC 
 

 

A PC adapter and possibly a control cabinet module are required for connecting 
devices. The descriptions of these programming tools are not part of this 
documentation. However they can be downloaded from the Accessories section on 
the website: 
http://www.tr-electronic.com/products/rotary-encoders/accessories.html 

 
 
Connection diagram, e.g. via PC adapter with SSI encoder 
 

 
 
 
Connection diagram, e.g. via IR adapter 
 

 
  

http://www.tr-electronic.com/products/rotary-encoders/accessories.html
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6 Program start 
 
The program is started from the menu Start --> Programs --> TRWinProg. 
 
 
You can register a shortcut of TRWinProg.exe in the Startup folder of Windows if 
TRWinProg is to be started automatically and immediately after Windows has started. 
 
 
The following info window appears for about 2 seconds after starting the program: 

 
 
The window briefly informs the user about the global program default settings, but has 
no input options. 
 
The information is limited to: 

- loaded program libraries (*.DLL) 
- used serial transfer options, e.g. IRDA, which means that an IR 

adapter is used for the communication between PC and device. 
- COM port used 
- language set 
 
 

For communication between PC and connected device to occur requires that 
these settings have been adjusted the user’s situation. Therefore make these 
settings first 
(see menu Tools --> Global in offline mode, page 16). 
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7 User interface 
 
Main screen of TRWinProg in offline mode without device and parameter file loaded. 
 
 

 
 
 
 
 

 Main Menu Bar (Chapter 7.1 from page 13) 

 Tool bar (Chapter 7.2 from page 21) 

 Menu Bar (Chapter 7.3 from page 22) 

 Status bar (Chapter 7.4 from page 24) 
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7.1 Main Menu Bar 
 
 
7.1.1 File Management 
 

 
Initially, the options Open , Save  and Print  under the File menu are 
inactive and only become active if a device file *.tr (definition of device type) has been 
selected and you are in offline mode. End  terminates the program TRWinProg. 
 
Use the option Open to load a saved “TR parameter file” (*.prm) into the program. A 
check is made during loading to verify whether the device ID in the parameter file 
matches the device ID of the loaded device file. This verification ensures that the 
parameter file and device file are only associated with a single device type. 
 
The file location for parameter files is the subdirectory “Data”, which is pre-selected 
when you open or save parameter files. 
 
The Save option saves every Device parameter, Project description, Worker 
and the related Comment in the parameter file belonging to a device file. The 
parameter file thus enables adjustments to be made to different customer applications. 
Several parameter files can therefore be associated with a single device file. 
 
The Print option prints the currently loaded parameter file as a list on the selected 
printer.  
 
The option Device list -> Actualise updates the list of all available devices 
files. 
 
Use the option Device list -> Import device to include a new device file. The 
program might have to be restarted after including a new device file for the file to 
appear in the device list. 
 
The option Log file display displays a list of system events that have been 
logged in the background of the program. Use the setting Extra -> Log file 
active to enable logging (see Chapter: 7.1.3.1). 
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7.1.2 Device communication 
 
In offline mode only the Online  option is active. Data read from 

device , Data write to device  and any other options are only active in 
online mode . 
 
The program attempts to connect to the connected device when you click on the 
Online option. Once the connection is established, the offline mode switches to the 
online mode. The status bar (Chapter: 7.4) displays additional information about the 
operating condition. An error message is displayed and the program remains in the 
offline mode if no communication can be established. If this is the case, ensure that all 
components are properly connected and that all possibly required hardware drivers 
have been installed on the operating system. 
 
The program analyzes the connected device and automatically loads the appropriate 
device file when establishing a connection. 
The programmed device parameters are compared with those of the loaded 
parameter file if a parameter file has been previously created and loaded as being 
associated with the current device file. A message indicates whether differently set 
parameters have been identified. In this case, a window displays a list of the differing 
parameters and provides a possibility to accept the device date in the PC, to store the 
PC data in the device or to cancel the operation. 
 

 
 
Data read from device causes the parameter data to be read from the device to 
the PC when in online mode. This action overwrites the PC data. 
 
Data write to device causes the parameter data to be sent from the PC to a 
device when in online mode. The device is thus programmed with the new parameter 
data. 
 
Read diagnosis memory permits reading the diagnostic memory for servicing 
purposes. This function must be supported by the measuring system. 
 
Reset device causes all unsaved parameters to be reset to their original values. 
This function must be supported by the measuring system. 
 
Default-Values restore resets the measuring system to the factory settings. 
This function must be supported by the measuring system. 
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7.1.3 Settings 
 
The menu items Logfile active, Options and Global can be selected in 
offline mode only. A device file must always be also loaded for the menu item 
Options to be selectable. 
 
 
 

7.1.3.1 Logfile active 
 
Start and stop the logging of the communication by selecting Logfile active. This 
function can be activated only in offline mode. Use the option File -> Log file 
display (see Chapter: 7.1.1) to display the log file. 
 
 
 

7.1.3.2 Options 
 
The Options menu provides an overview of all parameters relevant for a particular 
device type (device file). 
 

 
 
 
 
Select the appropriate parameter and the button visible to hide the parameter from 
the user interface if certain parameters are not required. 
Use the button all visible to display all listed parameters in the user interface. 
The button Display info shows some developers information and the currently 
used value of the selected parameter. 
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Use the button Remote to establish a remote maintenance with the “Remote Control” 
for service purposes. 
 

 
 
 
 

7.1.3.3 Global 
 
Use the option Global to set global program settings for communication and 
language. 
 

 
 
 
 

7.1.3.3.1 COM port 
 
Use CommPort to specify which serial port of the PC is to be used by the program 
TRWinProg to communicate with the connected device. This option is used to specify 
the virtual COM port if the USB port is used for communication. It supports COM1 
- COM6. 
 
Clicking the Show Serial Ports  button displays all available COM ports. 
Double click the required port to select it. 
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7.1.3.3.2 Language 
 
Sets the program’s user interface language. The associated national flag is displayed. 
 
You can select: 
 

- GER (German) 
- ENG (English) 
- ITA (Italian) 
- FRA (French) 
- ESP (Spanish) 
- SWE (Swedish) is currently not supported! 
- SUO (Finnish) is currently not supported! 
- POR (Portuguese) is currently not supported! 

 
 
 

7.1.3.3.3 DLL option 
 
Specifies the type of communication for the exchange of data: 
 

- Auto: 
The Baud rate is automatically selected by the program. The highest possible 
baud rate of both components (PC / measuring system) is determined and set 
and a PC adapter is used for communication. 

- 9600: 
The baud rate is set to a fixed 9600 baud and an RS232-PC adapter is used for 
communication. 

- IRDA(ACTiSYS): 
An infrared adapter is used for communication. 

- USB: 
A standard interface adapter (third-party product) is used for communication. 

- TR USB ADAPTER: 
A “TR-USB PC Adapter” is used for communication. 

- TR I2C Bus: 
An “I2C Bus” is used for communication. 

- TR TCP/IP: 
An Ethernet-based “TCP/IP” connection is used for communication. 

- USB-HID: 
A “USB PC adapter HID V5” is used for communication. 
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7.1.3.3.4 Option file 
Click on the button  to load an option file. Check Option file automatic 
load to automatically load the selected option file during the program start. 
 
 
 

7.1.3.3.5 Other buttons 
 

 
Click on this button to set the path to the folders with the device files. 

 
Click on this button to open the path to the device files “Devices”. 

 
Click on this button to open a window where global TRWinProg functions 
can be set (see Chapter: 7.1.3.3.6). 

 /  
Click on this button to apply or save the settings that were 
changed in the window Global . 
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7.1.3.3.6 Global settings 
A list of global program settings is displayed after clicking the button  in the window 
Global: 
 
 
The following service parameters may only be changed after consultation with  
TR-Electronic: 

- Grafik Sample Time (in 50 ms-Steps) -> default value = 1 

- CMD Delay (in μs) -> default value = 1000 

- Char Delay (in μs) -> default value = 1000 

- HID-Cycle (in ms) -> default value = 20 

 

Click the check box to enable or disable the following parameters: 

- Use Delayed Telegrams -> disabled by default: 
Enable / Disable service parameters. 

- Remote Enable -> enabled by default: 
Enable / Disable remote maintenance. 

- Search Registry Allowed -> disabled by default: 
Extend system access permissions for TRWinProg. 

- Parameter Acknowledge Enabled -> enabled by default: 
A confirmation box appears when downloading modified device parameters and 
indicates whether the parameter list is valid. 

- Parameter Quit Acknowledge Enabled -> enabled by default: 
A confirmation box appears before TRWinProg is closed. 

- Comm Port Auto Search Enabled -> disabled by default: 
Enables / disables automatic Baud rate detection (disabled = 9600 baud). 

- Printer Auto Search Enabled -> enabled by default: 
Enables or suppresses an alert to select a default printer. 

- Additional Help Permanent -> enabled by default: 
Enables / disables additional help. 

- File Copy at Startup -> disabled by default: 
Enables / disables comparing the local TRWinProg device directory with other 
device directories at program start. The program start is delayed if this parameter 
is enabled! 

- Refresh Device List at Startup -> enabled by default: 
Enables / disables updating the device list at program start. 

- Checking for Programm Updates -> disabled by default: 
Enables / disables the on-line search for new software updates at program start. 

- TRIC Reading Enabled -> disabled by default: 
Enables / disables the display of the device TRIC number (TR Identification 
Code) on the Basics tab. This function must be supported by the measuring 
system. 

 
Clicking the button  again closes the settings window. 
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7.1.4 Help functions 
 
 
Use the menu item Help-File or the icon  to open this document. 
 
The menu item Online help starts the download of the most recent version of this 
document. 
 
Programm-Info informs about 

• Program version 
• Driver name 
• Driver version 

 
 
 
An additional info symbol  appears for some devices in the tool bar and enables an 
additional device-specific Help for individual parameters. 
Hover the mouse pointer over an information symbol to display the help text of the 
respective parameter in a separate pop-up window. 
 
 
Example: 
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7.2 Tool bar 
 
 
 

 
Program end 

Firmware update 

 
Allows you to load a new firmware (optional) online 

Help functions 

 Enables an additional device-specific Help for individual parameters (optional). 

 
Displays this document 

File Management (for more information see page 13) 

 
Open a parameter file (*.prm) offline 

 
Save a parameter file (*.prm) offline 

 
Print a parameter file (*.prm) offline 

Device communication (for more information see page 14) 
 

 
Read device data into the PC online 

 
Write PC data to the device online 

 
Offline ---> Online offline 

 
Online ---> Offline online 
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7.3 Menu Bar 
 
The Basics menu is always displayed, independent of the connected device or the 
loaded device file. 
Other menus are added according to the device type when loading a device file in 
offline mode or when connecting a device in online mode. The associated version 
number of this file is displayed to the right of the device file display window.  
 

 
 
 
Use the input fields Project, Worker and Comment to describe the settings for a 
specific customer application in greater detail and to save them as a parameter file 
(*.prm) together with the adjusted parameters using File --> Save. 
 
In the online mode, the field Online provides information on: 

- the connected Device (Device ID), 

- the Firmware version, 

- the Firmware-date, 

- the Baud rate set, 

- the article number  (Art-No) and 

- the serial number (Ser-No) 

A product shot of the connected device appears on the right side of the field. 
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7.3.1 Parameter inputs 
 

 
 
 
You can make parameter changes in both offline mode and online mode. A 
requirement is that a device file has been loaded. 
Parameter entries are either entered via a drop-down menu button  from a list of 
defaults or by directly inputting parameter values. A red entry window frame marks 
changed parameters. 
The message Parameter changed! in the status bar (see also Chapter “Status 
messages”, from page 24) informs the operator of a global parameter change. This 
message and the changed-parameter highlight will be deleted when the parameters 
are transfered to the device in online mode or by saving the parameters in the 
parameter file in offline mode. 
The value range of direct parameter entries via the keyboard are checked for validity 
during entry. For example, the following error message indicates that the entry is 
either smaller or larger than the valid range: 
 
 

 
 
The parameter entry can be completed with a valid value only. 
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7.4 Status bar 
 
 

 
 
 

7.4.1 Status messages 
 
 

7.4.1.1 Communication messages [A] 

Communication started 

 Appears when changing from offline to online mode. This message is invisible 
to the user if the connection could be established without problems. A series of 
initialization processes is started when a connection is established, during 
which process the message Communication started will appear only very 
briefly.  
This message may remain in this status if the connection could not be 
established for any reason or is faulty. 

Communication stopped 

 Appears when changing from online to offline mode. 

Communication interrupted (see also Chapter 9.1, from page 28) 

 Appears when the online connection to the device is interrupted for longer than 
about 2 seconds. In this case, the online connection to the device must be 
reestablished manually via the program.  

Search Baud rate 

 Appears when changing from offline mode to online mode and the baud rate is 
set by the initialization process. 
This message may remain in this status until the connection is established, if 
the connection could not be established for any reason or is faulty. 

Get Device-ID 

 Appears when changing from offline mode to online mode and when the 
initialization process compares the device ID of the loaded parameter file with 
the device. 
This message may remain in this status if the connection could not be 
established for any reason or is faulty. 
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Waiting for parameter list 

 Briefly appears when changing from offline mode to online mode and when the 
initialization process provides the parameter list from the device for parameter 
comparison. 
This message may remain in this status if the connection could not be 
established for any reason or is faulty. A warning message is issued in this 
context if different parameter data have been detected: 

 
This error message is displayed when the warning message is acknowledged 
or when no parameter difference was detected: 

 
The process is canceled upon acknowledging the error message, the program 
remains in the offline mode and the status 
Device-file not available! is displayed. 

Read parameter from device 

 Appears when changing from offline mode to online mode and when the 
initialization process transfers the parameters from the device to the PC 
program. 
This message may remain in this status if the connection could not be 
established for any reason or is faulty. 

Write parameter to device 

 Appears when parameters are sent to the device in online mode. 

Read cyclic 

 Appears in online mode after the initialization process and when the 
communication with the device is working properly. 

Device-file not available! (see also Chapter 9.1, from page 28) 

 Appears when changing from offline mode to online mode and no device file 
was found for the connected device. This could be caused by: 

- the file was moved out of or deleted from the file system 
- the file was not supplied with the program 

Please request the appropriate device file (see program message) 
  



User interface 

 

 TR-Electronic GmbH 2001, All Rights Reserved Printed in the Federal Republic of Germany 

Page 26 of 33 TR - E - BA - GB - 0023 - 05 07/14/2017 

 
7.4.1.2 Parameter messages [B] 

 Parameter-list not actualised! 

 Appears when parameters are sent to the device in online mode and when a 
communication fault occurs during data transfer. Depending on the type of 
fault, this circumstance may also be displayed as an error message. The 
parameter transmission must be repeated 

 Parameter-list ok 

 Appears when parameters are sent to the device or are received by the device 
in online mode and the data transfer could be completed without fault (no 
parameter difference PC <--> device).  

 Parameter changed! 

 Appears when parameters have been changed in online mode in the user 
interface but have not yet been transferred to the device. In offline mode, this 
indicates that the parameters have not yet been saved in the parameter file.  

No option-file loaded (see also Chapter 9.1, from page 28) 

 Appears if no option file was loaded for the device file. This could be caused 
by: 
- so far, no option file has been created for the device 
- the original location of the created option file has been moved or 
deleted from the file system 
The message is overwritten by subsequent actions, such as changing 
parameters. 

 
 

7.4.1.3 Offline / Online Status [C] 

Offline!  

 Appears when the program is running in offline mode.  

Online!  

 Appears when the program is running in online mode. After a successful 
connection, the online time spent is also indicated. 
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8 Firmware update 
 
In some cases it is necessary to update a device firmware on site, for example when 
new device functionalities are to be used. 
 

Firmware updates may only be performed in consultation with TR-Electronic. For this 
purpose, the following data must be provided: 
 

Device: 
Firmware version: 
Firmware-date: 

 

see also Information “The online field …” at the bottom part on page 22. 
 
Use the menu Help-->Program Info to note 

the program version and 
Driver version 

. 
 
TR-Electronic creates a new device file (*.tr) and the associated binary file (*.bin) that 
matches the above data. TRWinProg must compy these two files into the subdirectory 
“... \Devices”. 
 

The firmware update symbol “ ” is added when the new device file is loaded. Using 
the icon , the firmware update can now be performed in online mode. 
 

Enter the (case sensitive!) password agreed with TR-Electronic in the next window: 
 

 
 
 
 
Click the Start button to start the firmware update. 
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9 Global error / warning messages 
 

9.1 Causes and remedies 
 
 

9.1.1 Status bar 
 

Program message 

Communication interrupted 

Cause 

The online connection to the device was interrupted for longer than about 2 
seconds. 

Remedy 

• Ensure, when using an IrDA adapter: 
- that the transmission path (transmitter <--> receiver) was not interrupted by 

objects, external influences (e.g. strong exterior light sources) etc., 
- that the IrDA adapter is aligned with the device, 
- that the distance IrDA adapter <--> device is within the specified limits 

• Check COM port socket for correct seating. 
• Check the power supply of the device to be programmed. 
• Make sure that no other software uses the selected COM port. 

• Check whether a power management function of your PC has reduced or shut 
down the power supply of the COM ports. 

 
 
 

9.1.2    Error messages 
 

Program message 

 Communication is not possible or faulty! 

Cause 

No connection could be established with the device via the selected port interface. 

Remedy 

• Make sure that a physically existing PC COM port has been selected via the 
menu Tools --> Global --> COM-Port and that the adapter is plugged in 
accordingly. 

• Ensure that the correct virtual COM port is used if the USB port is used for 
communication. 

• Make sure that no other software uses the selected COM port. 
• Check whether a power management function of your PC has reduced or shut 

down the power supply of the COM ports. 
 
… 
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… 
 

Program message 

 Wrong device-ID!! 

Cause 

An incorrect option file (*.prm) was loaded for a device file (device type) in offline 
mode. The device ID defines the device type and thus ensures that only 
appropriate parameters are loaded for a device type via option files.  

Remedy 

• Select an appropriate option file for a device file (File --> Open) and load it. 
• Modify the parameters of the loaded device file as required and save it as an 

option file (*.prm) (File --> Save) if no suitable option file exists and then load 
it into the program. 

Program message 

 No option-file!! 

Cause 

The option file (*.prm) recently created for the device file could not be found when 
loading a device file in offline mode or when establishing a connection in online 
mode. Provided “TRWinProg” was used as the working directory, the file location of 
the option file is the directory path 
“x:\TRWinProg\Data\*.prm”, whereby x is replaced by an appropriate drive letter. 

Remedy 

• Verify that the folder or the option file was not removed, deleted or renamed 
from or on the file system. 

• The option file must be re-created in the program if data were lost. 

Program message 

 Wrong option-file!! 

Cause 

A modification of the option file was detected when it was opened in offline mode. 

Remedy 

• A new option file must be created with the desired settings if the modification 
cannot be undone by editing it in a text editor. 

 
… 
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… 
 

Program message 

 Fail parameter-check! 

Cause 

A global parameter write error has occurred when sending parameters to the 
device. 

Remedy 

• Repeat the procedure if communication faults can be excluded. Please contact 
TR-Electronic if no parameters are transmitted to the device despite repeated 
attempts. 

Program message 

 Dynamic Link Library TRWPDLL does not exist! 
 Online functions are blocked! 

Cause 

The program library “TRWPDLL.dll” was not found when starting the program. 
Provided “TRWinProg” was used as the working directory, the file location of the 
program library is the directory path 
“x:\TRWinProg\DLLs\TRWPDLL.dll”, whereby x is replaced by an appropriate 
drive letter. 

Remedy 

• Verify that the folder or the program library was not removed, deleted or 
renamed from or on the file system. 

• In case of data loss, restore the file using the TR Program CD or request it from 
TR-Electronic.  

Program message 

 Device file does not exist! 
 Please order the following file from TR-Electronic: 
 *.tr 

Cause 

No device file was found for the connected device when attempting to change into 
the online mode. Provided “TRWinProg” was used as the working directory, the file 
location of the device file is the directory path “x:\TRWinProg\Devices\*.tr”, 
whereby x is replaced by an appropriate drive letter. 

Remedy 

• Verify that the folder or the device file was not removed, deleted or renamed 
from or on the file system. 

• In case of data loss, restore the file using the TR Program CD or request it from 
TR-Electronic.  

 
… 
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… 
 

Program message 

 No device-type-files found! 

Cause 

Not a single device file was found in the directory for device files when starting the 
program. Provided “TRWinProg” was used as the working directory, the file 
location of the device file is the directory path 
“x:\TRWinProg\Devices\*.tr”, 
whereby x is replaced by an appropriate drive letter. 

Remedy 

• Verify that the folder or the files were not removed, deleted or renamed from or 
on the file system. 

• In case of data loss, restore the files using the TR Program CD or request it 
from TR-Electronic.  

Program message 

 Directory with device-type-files doesn't exist! 

Cause 

The directory for device files was not found when starting the program. Provided 
“TRWinProg” was used as the working directory, the file location of the device file 
is the directory path 
“x:\TRWinProg\Devices”, 
whereby x is replaced by an appropriate drive letter. 

Remedy 

• Verify that the folder was not removed, deleted or renamed from or on the file 
system. 

• In case of data loss, restore the file using the TR Program CD or request it from 
TR-Electronic.  

Program message 

 Device-file not valid! 

Cause 

The device file was found to be outdated when loading a device file in offline mode 
or when establishing a connection in online mode. 

Remedy 

• Request a new device file from TR-Electronic. 

 
… 
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… 
 

Program message 

Device not identified! 

Cause 

The connected device couldn’t be identified based on the device ID / parameter list 
when attempting to switch to the online mode. 

Remedy 

• Repeat the procedure if communication faults can be excluded. Please contact 
TR-Electronic if the connected device cannot be identified despite repeated 
attempts. 

Program message 

 Error-No: x 
 Unknown ! 

Cause 

An operation has caused an unknown error in the program. 

Remedy 

• Repeat the procedure if communication faults can be excluded. Please contact 
TR-Electronic if the error occurs despite repeated attempts. 

 
 
 

9.1.3   Warning messages 
 

Program message 

 No HTML browser found! 
 The help function is not enabled! 

Cause 

No installed web browser was found at program start or a version was detected 
that does not interact with the program. Therefore, the help files cannot be 
displayed. 

Remedy 

• Install MS Internet Explorer Version 4 so you can use the Help function.  

 
… 
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… 
 

Program message 

 Language not available at present! 

Cause 

The language selected by the program Tools --> Global --> Language is 
currently not supported. 

Remedy 

• Select another language or ask TR-Electronic when the desired language will 
be available. 

Program message 

 Device data changed! 
 Restart communication !! 

Cause 

During the attempt to switch to the online mode, a data difference was found when 
data were transfered from the device to the PC.  

Remedy 

• Repeat the procedure if communication faults can be excluded. Please contact 
TR-Electronic if the warning occurs despite repeated attempts. 
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